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Welcome to the latest revisions to Australia's BullCharts charting software.  
This version (4.1) runs on Windows XP, Windows 7, Windows 8 (both 32-bit and 
64-bit) and the new Windows 10.

The previous upgrade (to version 4.0) was only one year ago, and included some 
key features such as: watchlist enhancements, Dynamic Market Depth bar charts, 
and many small tweaks and updates (eg. edit undo, alerts description column, 
BullScan enhancements and details for rejects, ex-div date indicator, etc.).

This upgrade to version 4.1 includes the following key features (plus others):

 Comparative Percent Performance chart — perhaps the most significant 
and useful of the new features.  This easily provides comparison of a stock’s
performance to other stocks, or to the market index, or to its own sector 
index.  (See sample on this page below.)

 Continuing with the theme of studying and comparing sector performance, 
there are new scans and chart indicators regarding market sectors and 
utilising the Relative Strength Comparison (RSC).

 A minor change, but some users will see this as very significant — 
the addition of a fourth Security Type into the Security Manager, to display 
a list of ETFs, as well as the existing: Indices, Ordinaries and Unit Trusts.

This document provides an overview of all the changes in this new Version 4.1.  
See a summary list in the Table of Contents on the next page.  Also refer to past 
“What's New” documents for a list of other revisions and changes in past version 
updates.
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email: info@bullsystems.com.au 
phone: 02 9495 8400

Comparative Percent 
Performance chart 

of BHP and RIO 
from December 2007. 

We can draw several conclusions
from this type of chart.
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Comparative Percent Performance chart (new)
One of the key new features in this version of BullCharts is the Comparative Percent 
Performance chart, as shown in the sample below.  This particular example is the ten 
sector indexes of the Australian market, and their individual percentage performance since
mid-2009.  We can tell at a glance how each of them have been performing by reading the 
vertical axis scale (percentage).  If we want to change the “start date” for the comparison, 
simply drag the chart (using the mouse) left or right — too easy.

See more details about this chart type on the next page.
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Comparative Percent Performance chart (continued)
One key feature of good charting software is the ability to display a single chart that 
directly compares the performance of one stock to another, or a stock to an index, or 
to its own sector index.  Such a chart could help to answer questions like:

● How has CBA bank been performing compared to its three big-bank peers 
in the last 3 months? OR even in the last 6 years?

● How has the CBA bank been performing compared to its own sector index 
(the S&P/ASX 200 Financials XFJ)?

The sample price chart below shows the percentage performance of the big four banks 
since the (arbitrary) “Start Date” of August 2009 (a monthly chart).

This Comparative Percent Performance price chart feature can display a price chart 
of either:

● A stock and its sector index; or

● Two (or more) stocks;

with the price of the plotted securities* displayed in terms of percentage change, and 
adjusted to the same level as at a base date that you specify.  The vertical (price) axis 
indicates percentage change of each individual security (not a dollar price).

The sample weekly price chart
at right shows the NAB bank
and its XFJ sector index since
3rd March 2014.  It clearly
shows that NAB is down about
5% since that start date, while
the XFJ sector index is up
about 5%.  This chart can help
to quickly visually look for
things like potential price mean
reversion candidates.

* — Securities refers to a 
stock or an index.
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Comparative Percent Performance chart (continued)

How to display the Comparative Percent Performance price chart:

1. Display a price chart for the stock that you wish to analyse.

2. Click on the new “Comparative Percent
Performance” toolbar button 
(see toolbar screenshot at right).

In the dialogue box that will appear (see
second screen shot at right) you have the
following options:

3. Start Date — Specify a date from
which the price change over time is
based.  The default Start Date of the
comparison (uncheck the tick box) is
from the left hand edge of the screen. 

4. Sector Index — Check this box so
that BullCharts will automatically display the relevant Sector Index* for that stock.  
If you are viewing a price chart for a stock that is in a watchlist, and you then select 
the next stock in the watchlist, the relevant sector index will be displayed.

5. Symbol field — To compare the displayed stock to one other stock, simply enter 
the stock code in the Symbol field.  To compare it to more than one other stock, 
enter the other stock codes separated by a comma (and with no spaces between 
the stock codes — only a comma).

Also note:

● If you view the chart with the vertical dashed red line indicating the start date for the
comparison, you can “grab” the vertical line (using the mouse cursor) and drag the 
line left or right to easily change the comparison start date.

● You can easily change many of the parameters for each price plot on the chart 
(either double-click on the particular price plot, or right-click and select “Properties” 
from the drop-down options list), including:

● The colour of each price plot line on the
chart (ie. to have a different colour for each
stock or index that is displayed).

● The “plot type” (candle, line, etc.).

● The “line style” for each price plot (dashed,
dotted, line, etc.).

* Sector indexes — To see a list of sector indices and
their codes in BullCharts, view the Security Manager
(see screen shot at right), and expand the “All
Securities” category, then the “Security Types”, and
click on the entry “Indices” to view all the indexes in the
lower window pane.
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WatchList Report window panel (new)
You might have a particular stock listed in several of your watchlists.  Have you ever 
wondered in which watchlists a particular stock is listed?  For example, you might be 
following a big mining company like BHP, and you might have added it to several 
watchlists, and you might have so many watchlists that it is difficult to keep track of which 
watchlists the stock is listed in.

If that’s the case, then you can
now generate a “WatchList
Report” in a new window “panel”
(somewhat like the “Price Info
Window” panel).

Refer to the sample screen shot
at right — a daily price chart of
ATC.  After generating the
WatchList Report, in this
particular case, it indicates that it
is listed in two watchlists: the
“Last Scan Results” watchlist and
in a watchlist called “Watch these
stocks”.

To generate this WatchList Report panel, use the menu option: 
View > Panels > WatchList Report Window (note that the keyboard short cut 
is: Control+Shift+W).
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Workspace Manager toolbar (new)
Firstly, here is a little reminder about Workspaces.  A Workspace is one or more price 
charts arranged in some manner within the BullCharts window, with each price chart 
containing attributes like coloured background, or time frame, etc., etc..  It might be, for 
example, three price charts — one a daily, one a weekly and one a monthly — arranged 
around the window, and all “synchronised” so you can view a stock from a watchlist, and 
instantly see the charts of the three time periods.  You could then step through the stocks 
in a watchlist to peruse the same view of consecutive stocks.  This “arrangement” of price 
charts can be saved as a BullCharts Workspace.  The Workspace Manager feature is one 
of several items in the BullCharts Control Panel, like the Security Manager and the Layer 
Manager, from where you can view a list of your saved Workspaces, and manage them 
(copy, delete, edit, etc.).

During your normal day, you might have a number of different Workspaces, and you might 
want to view one Workspace for a while, and then quickly close that Workspace and view 
a different one.  

For convenience, it is now possible to have shortcuts to your
favourite Workspace(s), as buttons on the new Workspace
toolbar (much like the Indicator toolbar and the Template
toolbar).  The sample screenshot at right shows the
Workspace toolbar which comprises the initial button to “Customise Workspaces”, and four
extra toolbar buttons for four custom Workspaces (which I have added to my own system).
The toolbar is initially located at the bottom of the BullCharts window, but can be dragged 
and re-docked anywhere around the window.

Use the “Customise Workspaces” toolbar button to add new toolbar buttons for your 
existing Workspaces.  This works much the same as the customise methods for the 
indicator toolbar and the template toolbar.  The screenshot below shows the dialogue box 
(on a Windows 7 system).  You can use the “Add...” button to locate the desired 
Workspace, and add it to the toolbar.  And you can change the “Toolbar Abbreviation” that 
appears on the toolbar button (up to 5 characters), and select the button colour.
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Display Sector and Industry Group (new)
in Detailed WatchList

The Detailed WatchList feature was introduced in the previous version 4.0 upgrade to 
BullCharts, and looks something like the sample in the screen shot below.  It shows all the 
stocks in a watchlist that you nominate, and a number of columns of information.

There are some 29 fields that can be selected to display across this table, and resequence
as you would like.  It is now possible to also display the Sector and Industry Group as 
shown in the sample above.  This list of stocks can be sorted by any column (single mouse
click on the column header, and note the small triangle shape in the column header to 
indicate the sorted column).

To display this Detailed Watchlist, identify an existing regular watchlist in the Security 
Manager, then right-click and select “View Detailed WatchList” from the drop-down menu 
(see the first screen shot below).  To resequence the columns, or add or remove columns, 
use the menu option: Format > Current View > Customise Current View (see the 
second screen shot below), or simply right-click on the list of stocks and select the option 
from the drop-down choices.  Then select the field to add from the Available columns (eg. 
“Sector”), then click on the Add button.  Then click on OK to modify the Current View.
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Training Mode (enhancement)
The Training Mode feature has existed in BullCharts for a while now.  It is best explained 
with reference to the price chart below.  

When enabled, this feature will cover the right hand portion of a price chart with a coloured
area to hide the more recent price action.  The left edge boundary of the Training Mode 
area can be grabbed with the mouse cursor and dragged left to hide more price action, or 
dragged right to reveal more price action.  In addition, the Training Mode toolbar buttons 
(usually docked in the bottom left corner of the BullCharts window) provide additional 
options to manage the Training Mode.  The purpose of this facility is to enable the user to 
study a price chart (along with any relevant tools or indicators) and consider the future 
price movement possibilities by interpreting the visible portion of the chart, and then 
revealing more price action.

In version 4.1, there are two key enhancements to this Training Mode feature as follows.

Auto Scroll

The existing Training Mode toolbar has
one new button to “Auto Scroll”.  When
this is enabled, the Training Mode
boundary will progressively move across
the screen from left to right, one bar at a
time and without manual intervention.  Adjacent to this button are the “+” and “-” buttons to 
scroll faster or slower.
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Training Mode (continued)

Customise colour of the Training Mode area

The background colour of the Training Mode area can be changed from the default pale 
green.  This option is available as a tab in the “Time Axis” properties dialogue.  To view 
and modify this, either select the menu item: Format > Time Axis > Training (tab).  
Alternatively, right click on the time axis of the chart and select “Time Axis Properties...” 
from the drop-down menu options.
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Selecting Row Colour in WatchList (enhancement)
A recent enhancement to the watchlists in the
BullCharts Security Manager was the ability to
colour an entry in a watchlist (as indicated in the
adjacent screenshot sample).

To apply a colour to a watchlist entry, simply right-
click on the entry, and choose “Select Colour” from
the drop-down menu.  You can also apply the
colour using a keyboard sequence with the <Ctrl>
key (the Control key).  For example, <Ctrl>+2 will
apply the first colour from the list (the colours can
be modified — right-click on the “Watchlists” entry
in Security Manager, and select “Properties”, then
“Sort Order” tab).  Note that for this to work, the
Security Manager panel needs to be the “active”
panel in the window.  You might need to click in
the watchlist panel to make this the “active” panel.

With BullCharts version 4.1 it is now possible to
utilise a shortcut via the keyboard’s numeric keypad to select the colour.  The valid 
numbers are 1 through 7, where 1 = No Colour.  This compliments the keyboard method of
using <Ctrl>+2 etc.  It does not work on the number keys which are located across the top 
of the keyboard.  Note that on a laptop that does not have a separate numeric keypad, you
might need to enable the numeric key equivalent on the keyboard.

Add in ETFs under Security Type in the Security Manager
The Security Manager panel hierarchy is shown 
in the adjacent screen shot.  

Note that under the “All Securities” item, 
if we expand the “Security Types” heading, 
there is now a fourth entry — “ETFs”. 

This will display all of the securities that are
classified as a Security Type of “ETF”.  The
security type is also listed in the “Security
Summary” details for each security 
(available from the toolbar button, or from the
menu option: Actions > Security). 
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New RSC Indicators: Outperforming Sector/Market
Many investors like to understand the relative strength of a stock compared to its own 
sector index.  Or perhaps the strength of a sector index compared to a market index.  
These three new chart indicators allow you to do that easily.  These complement the 
existing Relative Strength Comparison (RSC) chart indicator.

RSCAS — RSC against Sector
Starting with a price chart of a stock, insert this indicator to the price chart, and it 
automatically generates the RSC for the relevant sector index for the stock.  For example, 
if you have a price chart of a bank, this indicator will automatically apply the RSC indicator 
for the S&P/ASX 200 Financials sector index (XFJ).  It also includes the Moving Average 
of the RSC curve (the default is 21 periods).  This RSC indicator is simply the ratio of the 
Close price for the stock in each period, divided by the relevant sector index (or use the 
optional parameter to invert the chart).  This is the same as the existing RSC indicator 
which prompts for the index or stock to compare to, except that this one does not prompt 
for the sector index code to compare to.

RSCOSI — RSC of Sector Index
Starting with a price chart of a stock, insert this indicator to the price chart, and it 
automatically generates the RSC which is the relevant sector index compared to any other 
index or security (specified by the user).  It also includes the Moving Average of the RSC 
curve (default is 21 periods).  This is simply the ratio of the Sector Index for the stock, 
divided by the index (or security) specified by the user.

RSCWMA — RSC with MA
This is simply the standard RSC, with a Simple Moving Average (SMA) applied.  Like the 
standard RSC, this prompts for the index to compare to.

The BullScript code
The following table shows the BullScript code for these indicators, for the advanced users 
who are keen to see how they work (and to help introduce BullScript to other users).

RSCAS — RSC against 
Sector

RSCOSI — RSC of Sector 
Index

RSCWMA — RSC with MA

invert := 
input("0=normal, 
1=invert", 0,0,1);
n := input("Time 
periods",21,1);

_RSC:=if (invert=1,
LoadSymbol(security.sect
orindex,c)/C,
C/LoadSymbol(security.se
ctorindex,c));

[Color=Black;
name="RSC"] _RSC;
[Color=DarkRed;
name="MA"]
MA(_RSC,n,SIMPLE);

symb := 
inputsymbol("Compare 
to", "XAO");

invert := 
input("0=normal, 
1=invert", 0,0,1);
n := input("Time 
periods",21,1);

_RSC:=if (invert=1,
LoadSymbol(symb,C)/LoadS
ymbol(security.sectorind
ex,c),
LoadSymbol(security.sect
orindex,c)/LoadSymbol(sy
mb,C));
[Color=Black;
name="RSC"] _RSC;
[Color=DarkRed;
name="MA"]
MA(_RSC,n,SIMPLE);

symb := 
inputsymbol("Compare 
to", "XAO");

invert := 
input("0=normal, 
1=invert", 0, 0, 1);
n := input("Time 
periods",21,1);

_RSC:=if (invert=1,
LoadSymbol(symb,C)/C,
C/LoadSymbol(symb,C));

[Color=Black;
name="RSC"] _RSC;
[Color=DarkRed;
name="MA"] 
MA(_RSC,n,SIMPLE);

Page 11 of 14 Printed: 20 Sep 2015 (Version 1)



What's New in BullCharts version 4.1

New RSC Scans: Outperforming Sector/Market
NOTE:  A casual glance at the sample price charts below, and any charts generated after 
running the scan yourself, might draw you to some conclusions that might not be 
technically correct.  In order to properly analyse these results, it is important to have a 
good understanding of the concept of “Relative Strength”, and the Relative Strength 
Comparison (RSC), and how to interpret a comparison of a stock with its own sector index 
or the market index.

RSC Outperforming for a Symbol
This scan uses the (new) indicator: “RSC with MA” (RSCWMA).  With the default 
parameters this scan looks for all stocks with the RSC condition as described below, using 
the Relative Strength Comparison of each stock compared to the All Ordinaries index 
(XAO).  This can easily be changed to any other index by editing the Scan Criteria, and 
changing the drop-down selections.

The RSC condition that is scanned for is as follows: The RSC of the stock is greater than 
the Moving Average of the same RSC, every bar for 5 bars, on weekly data.  That is, the 
RSC is greater than its own Moving Average.  Note that the RSC value can be a very small
number (because the index value is so large), so the Scan Criteria multiplies the RSC 
values by a factor of 1,000.

After running this scan, and
generating a price chart, the chart is
as shown in the adjacent screen
shot.  Note the bottom pane of the
chart includes the new “RSC with
MA” indicator.  This indicator
comprises two lines: the RSC (the
black line) and the Moving Average
of that RSC (the red curve).  
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RSC Outperforming the Market and its Sector
This scan uses all three of the (new) RSC related indicators, in three separate BullScan 
criteria (described below).  In each case, the RSC comparison is performed against the 
XAO index (All Ordinaries), and this can easily be changed using the drop down selections
in the scan criteria.  (The All Ordinaries index is used here to represent the market.)

The three criteria which must all be satisfied are as follows (on weekly data):

• The first criteria is the same as in the first scan above — RSC Outperforming for a 
Symbol, using the “RSC with MA” indicator.  For the RSC it compares the stock to 
the XAO index, and looks for the RSC value to be greater than the MA of the RSC 
over 5 bars.

• The second criteria is similar to the first, except it compares the relevant sector 
index to the XAO index (not the stock to the index), using the “RSC of Sector 
Index” indicator.  As before, it looks for the RSC value to be greater than the MA of 
the RSC over 5 bars.  (This comparison of the two indexes does not need the 
multiplier of 1000).

• The third criteria is again similar to the above, except it compares the stock to its 
relevant sector index, using the “RSC against Sector” indicator.  As before, it looks
for the RSC value to be greater than the MA of the RSC over 5 bars.  (This 
comparison uses a multiplier value of 100).

After running this scan, and generating
a price chart, the chart is as shown in
the adjacent screenshot.  Note the
three extra panes in the chart — one for
each of the three criteria (and each of
the three indicators) with the
corresponding Moving Average curves
(the red curve in each case). 
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RSC Sectors Outperforming the Market
Like the first scan above, this scan uses the (new) indicator: “RSC with MA” (RSCWMA).  
But the key difference is that this scan searches through the list of indices, to identify the 
sector indices that are outperforming the market.  Note the following key points;

1. The list of “Securities to Scan” (the third tab in the BullScan Properties dialogue 
box) specifies the list of “Indices” in the Security Manager (today, this list contains 
32 market indexes).  (Normally, a scan will use your “Default Scan Group” which is 
set by using the Security Manager to find your preferred watchlist to scan across, 
then right-click and from the drop-down menu select “Default Scan Group”.  This 
watchlist is then highlighted as bold in the Security Manager).

2. The scan will search through the list of indices and calculate the RSC comparing 
each index to the All Ordinaries index (XAO).

3. As above with the other scans, it looks for the RSC value to be greater than the 
Moving Average of the RSC (but of the previous bar), for every bar for the last 5 
bars (on a daily chart).

After running this scan (on weekly data), and generating a price chart, the chart is as 
shown below.  Note the bottom pane of the chart includes the new “RSC with MA” indicator
(the black line) and its Moving Average (the red curve).  We can see that the RSC curve is 
above the MA of the RSC for the previous bar, for at least the last 5 bars.
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